IPCC Administration Guide for
Cisco Unified Contact Center Enterprise
7.5(1)

July 2011
# Table of Contents

Preface ...........................................................................................................................................1  
Purpose .........................................................................................................................................1  
Audience .........................................................................................................................................2  
Organization ....................................................................................................................................2  
Related Documentation ..................................................................................................................2  
Conventions ......................................................................................................................................2  
Obtaining Documentation and Submitting a Service Request.........................................................3  
Documentation Feedback ................................................................................................................3  

**Part 1. Managing IPCC Enterprise Agents and Call Routing** .......................................................5  
1. IPCC Enterprise Agents ..............................................................................................................7  
   About Administering IPCC Enterprise agents ...........................................................................7  
   What is an IPCC Enterprise agent? ............................................................................................7  
   ICM Database Records for IPCC Enterprise Voice-Only Agents .............................................8  
   Database Records for IPCC Enterprise Multichannel Agents ................................................8  
   About Agent Desk Settings .......................................................................................................9  
   About Agent Teams and Supervisors ......................................................................................9  
   About Agent Teams and Multichannel Applications ................................................................10  
2. Configuring CTI OS and CAD Desktop Features ......................................................................13  
   About Configuring Agent Features with Agent Desk Settings List Tool .................................13  
   Agent Wrap-up .........................................................................................................................13  
   Reason Codes ............................................................................................................................14  
   Agent Desk Settings That Affect Reason Codes .......................................................................14  
   Predefined Reason Codes .........................................................................................................15  
   Redirection on No Answer ..........................................................................................................17  
   Emergency and Supervisor Assist Calls ..................................................................................17  
   About Configuring Supervisor Features ................................................................................18  
   Barge-in .....................................................................................................................................18  
   Intercept ....................................................................................................................................19  
   About the Cisco IPCC Enterprise Agent Re-skilling Tool .........................................................19  
   Modifying the Skill Groups Per Agent Limit .............................................................................19  
   Using the ConfigLimit Tool ........................................................................................................20  
   Additional Requirements ............................................................................................................20  
   About Network Transfer for IVRs ..............................................................................................21  
   About IPCC Enterprise Routing ...............................................................................................21  
   About Routing Operation ...........................................................................................................21  
   About Routing Configuration .....................................................................................................23  
   About Routing Scripts ................................................................................................................26  
3. Routing Tasks for Multichannel Options ....................................................................................27  
   Configuring ICM/IPCC software for Multichannel Routing .....................................................27  
   Configuring Multichannel Software ............................................................................................28  

**Part 2. Performing Administrative Tasks with Cisco IPCC Enterprise** ........................................29  
4. Administering Agents .................................................................................................................31  
   How to Administer Agents .........................................................................................................31  
   How to Create IPCC Enterprise Voice-Only Agents .................................................................31  
   How to Delete IPCC Enterprise Voice-Only Agents .................................................................32
List of Figures

Figure 1: Dialed Number Plan Entry Specifying ICM Routing for the Agent Call

51
Preface

Purpose

This guide describes how to administer components of the Cisco IP Contact Center (IPCC) Enterprise solution. It includes information about administering IPCC Enterprise for voice and multichannel contact centers.

Note: The information in this guide does not pertain to specifics of System IPCCE deployments. The Cisco IPCC Enterprise Web Administration Tool is used for administering System IPCCE.

Access to the IPCC Web Administration Tool is limited to individuals with IPCC administrator privileges.

To access the IPCC Enterprise Web Administration Tool:

1. In your browser’s address bar, enter: https://<Administration & WebView Reporting machine DNS or IP address>/ipccAdmin.

2. Press Enter.

   The Login page displays.

   Note: The first time you access the IPCC Web Administration Tool you may be prompted to accept a security certificate.

3. Enter your IPCC administrator username and password.

   Passwords are case-sensitive.

   Note:
   • Log in with your Active Directory username and password.
Audience

This document is intended for contact center supervisors and administrators.

Organization

The following table describes the information contained in each section of this guide:

<table>
<thead>
<tr>
<th>Section</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Part I: Managing IPCC Enterprise Agents and Call Routing (page 5)</td>
<td>Provides conceptual information about IPCC Enterprise agents, agent features, and call routing.</td>
</tr>
<tr>
<td>Part II: Performing Administrative Tasks with Cisco IPCC Enterprise (page 29)</td>
<td>Describes how to perform administrative tasks using IPCC Enterprise with ICM software.</td>
</tr>
</tbody>
</table>

Related Documentation

For additional information about Cisco Intelligent Contact Management (ICM) software, see the Cisco web page (http://www.cisco.com/univercd/home/home.htm) listing ICM documentation. Refer to the Documentation Guide for Cisco IPCC Enterprise Edition for a complete list of IPCC documentation.

Conventions

This manual uses the following conventions:

<table>
<thead>
<tr>
<th>Convention</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>boldface font</td>
<td>Boldface font is used to indicate commands, such as user entries, keys, buttons, and folder and submenu names. For example:</td>
</tr>
<tr>
<td></td>
<td>• Choose Edit &gt; Find.</td>
</tr>
<tr>
<td></td>
<td>• Click Finish.</td>
</tr>
<tr>
<td>italic font</td>
<td>Italic font is used to indicate the following:</td>
</tr>
<tr>
<td></td>
<td>• To introduce a new term. Example: A skill group is a collection of agents who share similar skills.</td>
</tr>
<tr>
<td>Convention</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>-------------</td>
</tr>
<tr>
<td>• For emphasis. Example: <em>Do not</em> use the numerical naming convention.</td>
<td></td>
</tr>
<tr>
<td>• A syntax value that the user must replace. Example: IF (condition, true-value, false-value)</td>
<td></td>
</tr>
<tr>
<td>• A book title. Example: See the <em>Cisco CRS Installation Guide</em>.</td>
<td></td>
</tr>
<tr>
<td><strong>window font</strong></td>
<td>Window font, such as Courier, is used for the following:</td>
</tr>
<tr>
<td>• Text as it appears in code or that the window displays. Example: <code>&lt;html&gt;&lt;title&gt;Cisco Systems, Inc. &lt;/title&gt;&lt;/html&gt;</code></td>
<td></td>
</tr>
<tr>
<td><code>&lt; &gt;</code></td>
<td>Angle brackets are used to indicate the following:</td>
</tr>
<tr>
<td>• For arguments where the context does not allow italic, such as ASCII output.</td>
<td></td>
</tr>
<tr>
<td>• A character string that the user enters but that does not appear on the window such as a password.</td>
<td></td>
</tr>
</tbody>
</table>

### Obtaining Documentation and Submitting a Service Request

For information on obtaining documentation, submitting a service request, and gathering additional information, see the monthly *What's New in Cisco Product Documentation*, which also lists all new and revised Cisco technical documentation, at:


Subscribe to the *What's New in Cisco Product Documentation* as a Really Simple Syndication (RSS) feed and set content to be delivered directly to your desktop using a reader application. The RSS feeds are a free service and Cisco currently supports RSS version 2.0.

### Documentation Feedback

You can provide comments about this document by sending email to the following address:

[mailto:ccbu_docfeedback@cisco.com](mailto:ccbu_docfeedback@cisco.com)

We appreciate your comments.
Part 1: Managing IPCC Enterprise Agents and Call Routing

The following sections provide conceptual information about IPCC Enterprise agents, agent features, and call routing.
About Administering IPCC Enterprise agents

What is an IPCC Enterprise agent?

An agent is an individual who handles customer contact within your contact center. In an IPCC Enterprise configuration, you can create two types of agents:

<table>
<thead>
<tr>
<th>Agent type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Voice-only agents</td>
<td>Agents able to receive telephone calls. You can also configure Voice-only agents to receive non-voice requests such as Single-session Chat, Multi-Session Chat, Blended Collaboration, and E-Mail.</td>
</tr>
</tbody>
</table>
| Multichannel agents| Agents able to receive voice calls and requests from other media. You can also configure multichannel agents to only receive non-voice requests such as Single-session Chat, Multi-Session Chat, Blended Collaboration, and E-Mail.  
**Note:** You must have Cisco’s multichannel software installed as part of your IPCC Enterprise configuration to create multichannel agents. |

**Note:** In most cases, the Cisco Unified Communications Manager (Unified CM) peripheral on the Generic IPCC peripheral gateway (PG), which is set up with your initial IPCC Enterprise installation, tracks and records the state and activity of all voice and non-voice agents. You can configure a Non-Voice PG rather than a Unified CM PG to monitor state and activity of agents configured as non-voice agents. However, this is optional, and is not necessary if you already
have a Unified CM peripheral on the Generic IPCC PG. When using System IPCC, agent tracking is performed using the Agent/IVR Controller.

ICM Database Records for IPCC Enterprise Voice-Only Agents

In the ICM database, each agent must be associated with two database records:

<table>
<thead>
<tr>
<th>ICM database record</th>
<th>Description</th>
</tr>
</thead>
</table>
| Person record       | Identifies the individual. Person records must exist for all IPCC Enterprise agents. Every agent in your configuration must have a single Person record. This record can then be associated with one or multiple agent records, as described below.  

**Note:** System IPCC automatically sets the Person record. In System IPCC, there is a one-to-one correspondence between the agent and the person. |
| Agent record        | Identifies the agent working on a particular peripheral. There must be a one-to-one correspondence between each agent record and its associated peripheral. However, in IPCC Enterprise, if an agent is going to be working on several peripherals, you can create several agent records and associate these with the same person record. In this way, a single agent can work on several different peripherals. In System IPCC, this only works if done from the parent system. |

When you create an Agent record, you have the option of associating it with an existing Person record (click Select Person). If you do not associate the Agent record with an existing Person record, a new Person record is automatically created when you create the agent.

Database Records for IPCC Enterprise Multichannel Agents

IPCC Enterprise agents who will use multichannel software are associated with three different database records:

- The person record in the ICM/IPCC database
- The agent record in the ICM/IPCC database
- The agent record in the database for the multichannel application (Cisco Collaboration Server or Cisco E-Mail Manager)

You can create multichannel agents using either the ICM/IPCC Administration User Interface or the Administration interface for the multichannel software. The following table explains why creating multichannel agents using the multichannel software is the preferred method for agent creation.
If you create agents using the multichannel software:

You must create an agent record in ICM/IPCC software. (Note that a Person record is automatically created).

To handle multichannel contact, agents created in this way must be enabled in the associated multichannel software.

For example, assume that you create an agent using the ICM/IPCC Administration User Interface and you want that agent to be able to handle Web-initiated Single-session chat, Multi-session chat, and/or Blended Collaboration requests. To do so, you must use the Collaboration Administration desktop to enable the agent on the Collaboration Server.

If you create agents using the ICM/IPCC Administration User Interface:

Agent and person records are automatically created in both the multichannel software’s database and the ICM database.

You need not create a person or agent record in the ICM/IPCC Administration User Interface.

For agents who will work only in the multichannel non-Voice MRDs, create the agents in the multichannel applications.

For voice agents who also handle multichannel tasks, set up these agents in the multichannel applications first, then add the agents to a voice skill group in ICM/IPCC software.

Note: Agents already created in ICM/IPCC software that belong to voice skill groups can be enabled in Cisco E-Mail Manager or Cisco Collaboration Server through their respective administration interfaces, and can be added to email and collaboration skill groups.

Configuring an agent for multichannel requires you to assign the agent skill groups for each media type the agent is expected to handle. For example, the agent might handle both e-mail and phones, Single-session chat and phones, or Blended Collaboration and E-Mail.

### About Agent Desk Settings

Each agent record must be associated with an Agent Desk Setting. The Agent Desk Settings configuration is used to associate a set of permissions or characteristics with specific agents. These settings are comparable to Class of Service settings on a PBX or ACD. Desk settings are associated with an agent when the agent is configured in the ICM database. The desk settings are global in scope and they can be applied to any configured agent on any peripheral within an ICM/IPCC configuration.

If desktop settings are not associated with a configured agent, the agent is assigned the peripheral default settings. The peripheral default settings depend on the default setting for the Generic IPCC PG the agent is logged in to.

**Note:** See [About Configuring Agent Features with Agent Desk Settings List Tool (page 13)](#) for detailed information.

### About Agent Teams and Supervisors

You can organize IPCC Enterprise voice agents into teams. A team is a collection of agents grouped for reporting purposes. Note that a single agent can belong to only one team.
ICM/IPCC software allows you to group individual agents into agent teams that can be managed by supervisors. Agent teams are assigned to a specific peripheral, so all agents of a given team must also be assigned to the same Unified CM peripheral.

ICM/IPCC software lets you assign both Primary and Secondary supervisors to an individual team. It is recommended that you set up your teams with both a Primary and a Secondary supervisor. This setup helps to accommodate Supervisor and Emergency assist scenarios.

Supervisors listed on the Agents team list are able to view real-time statistics (via WebView). Supervisors can, for example, barge-in, intercept, silently monitor, and log out agents in the associated team using the CTI Toolkit IPCC Supervisor Desktop (Win32) application.

**Note:** If you use Cisco Agent Desktop (CAD), you must configure the supervisor in ICM/IPCC software first, then configure the supervisory features within CAD.

For reporting purposes, you can report on agent teams and agents grouped into teams. Also, supervisors can run reports on their teams. (Refer to the Reporting Guide for Cisco IPCC Enterprise & Hosted Editions for detailed information about reporting.)

Each team you set up must have an agent supervisor associated with it. You can then configure supervisory agent features, to allow the supervisor to better monitor agent activity and assist agents on their team. When you create an agent supervisor, you must enter the following information for the supervisor:

- Windows Domain name to which the agent team belongs
- Windows User ID for the supervisor
- Windows password for the supervisor

When configuring agent teams, be aware of the following rules:

- An agent can be a member of only one agent team.
- An agent team can have only one Primary Supervisor
- A supervisor can be a supervisor of any number of agent teams.
- A supervisor for an agent team can also be a member of that agent team.
- All agents belonging to an agent team and all supervisors for that agent team must be on the same peripheral.
- A supervisor cannot be using the Windows administrator account when logging in as supervisor.

### About Agent Teams and Multichannel Applications

You can group voice agents into teams using the ICM/IPCC Administration User Interface. Note, however, that there is no team feature in Collaboration Server or in the ICM-integrated
E-Mail Manager (teams are available for stand-alone E-Mail). Therefore, Collaboration-only agents and E-Mail-only agents cannot be grouped into teams.

See Also

For information about agent features, see Configuring CTI OS and CAD Desktop Features (page 13).

Chapter 2

Configuring CTI OS and CAD Desktop Features

This chapter contains the following topics:

- About Configuring Agent Features with Agent Desk Settings List Tool, page 13
- About Configuring Supervisor Features, page 18
- About the Cisco IPCC Enterprise Agent Re-skilling Tool, page 19
- Modifying the Skill Groups Per Agent Limit, page 19
- About Network Transfer for IVRs, page 21
- About IPCC Enterprise Routing, page 21

About Configuring Agent Features with Agent Desk Settings List Tool

Each voice agent record must be associated with an Agent Desk Setting (not necessary for non-voice agents). The Agent Desk Settings List tool configuration is used to associate a set of permissions or characteristics with specific agents. You can use the Agent Desk Settings List tool to configure the following agent features:

- Agent Wrap-up
- Reason Codes
- Redirection on No Answer
- Emergency and Supervisor Assist Calls

Agent Wrap-up

Agents can enter Wrap-up mode after completing a call. Wrap-up mode enables the agent to finish with any tasks that require after-call work before entering a Ready state. When in Wrap-up mode, the agent is not routed any additional tasks.
Agents can manually enter Wrap-up state by activating the wrap-up button on their soft phone. You can also configure Agent Desk Settings so that agents automatically enter Wrap-up mode after finishing each call.

When you create Agent Desk Settings using the ICM/IPCC Administration User Interface, you can specify whether agents enter Wrap-up mode automatically after finishing incoming calls. The Work Mode Settings allow you to specify whether the agent must enter Wrap-up mode after incoming calls. You can also use these settings to require agents to enter reason codes while in Wrap-up mode (incoming calls only).

**Reason Codes**

Agents select reason codes when they:

- Log out of the agent desktop system
- Enter Wrap-up mode after a call
- Change to a Not Ready state

Reason codes allow you to track the agent’s state and logout status as it changes. You configure reason codes using the agent desktop application (CTI OS and/or the CAD administrator's desktop). If you use the CTI OS desktop, you can also configure ICM/IPCC software to control when reason codes are required.

**Agent Desk Settings That Affect Reason Codes**

<table>
<thead>
<tr>
<th>Agent Desk Setting Option</th>
<th>Affects this type of reason code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Work mode on Incoming</td>
<td>Wrap-up</td>
</tr>
<tr>
<td>Idle reason required</td>
<td>Not Ready</td>
</tr>
<tr>
<td>Logout reason required</td>
<td>Logout</td>
</tr>
</tbody>
</table>

**Wrap-Up Reason Codes and Work Mode**

If you use the CTI Toolkit Agent Desktop (Win32), you can use the Work Mode on Incoming option on the Agent Desk Settings List window to specify when and if agents are required to enter reason codes when entering wrap-up for incoming calls. The following table describes Work Mode on Incoming options and explains how reason codes are related to each:

<table>
<thead>
<tr>
<th>Work Mode</th>
<th>Description</th>
<th>Reason Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Required</td>
<td>Ensures that the agent automatically enters Wrap-up state after completing the call.</td>
<td>The agent can choose to enter a reason code.</td>
</tr>
<tr>
<td></td>
<td></td>
<td>If the agent uses the wrap-up button, the agent can choose to enter a reason code.</td>
</tr>
<tr>
<td>Optional</td>
<td>Allows agents to choose whether to activate the wrap-up button or the Not Ready button to end the call.</td>
<td></td>
</tr>
</tbody>
</table>
The following table describes the CAD configuration for Work Mode on Incoming options:

<table>
<thead>
<tr>
<th>Work Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Not Allowed</td>
<td>Restricts the agent from entering Wrap-up mode. The Agent can go into Not Ready mode.</td>
</tr>
</tbody>
</table>
| Required with wrap-up data | Ensures that the agent automatically enters Wrap-up state after completing the call.  
  **Note:** This mode is not supported for outgoing calls. |

The following table describes the CAD configuration for Work Mode on Outgoing options:

<table>
<thead>
<tr>
<th>Work Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Required</td>
<td>When the agent drops an outbound call, the agent goes into a Work Not Ready state for the time specified in the Wrap-up time in the agent desk settings and pops the Wrap-up options, if they are enabled in the CAD Desktop Administrator application.</td>
</tr>
<tr>
<td>Optional</td>
<td>Recommended setting if not using Wrap-up options for outbound calls.</td>
</tr>
</tbody>
</table>

Predefined Reason Codes

IPCC Enterprise uses several predefined reason codes to indicate certain system events, described in the following table:

<table>
<thead>
<tr>
<th>Reason Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>32767</td>
<td>Agent state changed because the agent did not answer the call.</td>
</tr>
<tr>
<td>50001</td>
<td>The CTI OS client disconnected, logging the agent out.</td>
</tr>
</tbody>
</table>

  **Note:** This reason code is converted to a 50002, so 50001 does not display in the agent log out records.
### Reason Code | Description
---|---
50002 | A CTI OS component disconnected, causing the agent to be logged out or set to the Not Ready state. This could be due to closing the agent desktop application, heart beat time out, or a CTI OS Server failure.
50003 | Agent was logged out because the Unified CM reported the device out of service.
50004 | Agent was logged out due to agent inactivity as configured in agent desk settings.
50010 | Agent was set to Not Ready state because the agent was routed two consecutive calls that did not arrive.
50020 | Agent was logged out when the agent’s skill group dynamically changed on the AW.
50030 | If an agent is logged in to a dynamic device target that is using the same dialed number (DN) as the PG static device target, the agent is logged out.
50040 | Mobile agent was logged out because the call failed.
50041 | Mobile agent state changed to Not Ready because the call fails when the mobile agent's phone line rings busy.
50042 | Mobile agent was logged out because the phone line disconnected while using nailed connection mode.
-1 | Agent reinitialized (used if peripheral restarts).
-2 | PG reset the agent, normally due to a PG failure.
-3 | An administrator modified the agent’s extension while the agent was logged in.

These reason codes appear in these reports:

- Agent log out reports if the event caused the agent to log out
- Agent real time reports if the agent was set to a Not Ready state
- Agent Not Ready reports

**Note: Important!** For reporting on all pgs other than VRU PGS, be sure to select the Agent event detail check box on the Agent Distribution tab in the ICM/IPCC Administration User Interface’s PG Explorer tool. This check box must be enabled to report on Not Ready reason codes.

If you are using CAD, the Desktop Administrator uses the following predefined reason codes:

### Reason Code | Description
---|---
20001 | Places the agent in the Not Ready state first before forcefully logging them off.
### Reason Code | Description
--- | ---
20002 | Forces the logout request; for example, when Agent A attempts to log in to Cisco Agent Desktop and Agent B is already logged in under that agent ID, Agent A is asked whether or not to force the login. If Agent A answers yes, Agent B is logged out and Agent A is logged in. Reports would then show that Agent B logged out at a certain time with a reason code of 20002 (Agent B was forcibly logged out).  
**Note:** Cisco Unified Mobile Agent is the only exception, where CAD will not allow you to log out a login name/ID that is already in use.

20003 | If not already in the Logout state, request is made to place agent in the Not Ready state. Then logout request is made to log agent out.

<table>
<thead>
<tr>
<th>Reason Code</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supervisor Not Ready</td>
<td>This code is reserved.</td>
</tr>
<tr>
<td>Supervisor Logout</td>
<td>This code is reserved.</td>
</tr>
</tbody>
</table>

### Redirection on No Answer

You can configure your IPCC Enterprise system to handle and accurately report on situations when the agent does not answer his or her phone. These situations are referred to as Redirection on No Answer.

Although you can specify some values that control Redirection on No Answer situations, configuring Redirection on No Answer involves additional steps:

- ICM/IPCC configuration
- ICM/IPCC scripting
- Unified CM configuration

Redirection on No Answer conditions are handled by two routing scripts: the initial routing script and a script specifically set up for these conditions. The initial routing script handles the incoming call; when the call is redirected on no answer from the agent’s IP phone, the script branches to another script set up specifically for Ring No Answer conditions.

**Note:** The Target Racer script feature, implemented using the Label, Queue, Route Select, and Select nodes, is not supported for IPCC Enterprise systems; however, it is supported for Cisco Unified Customer Voice Portal (C.P.).

### Emergency and Supervisor Assist Calls

Agents can activate supervisor assist or emergency assist buttons on their desktop when they need special assistance from the primary or secondary supervisor assigned to their team.

Agents can use the Supervisor and Emergency assist features, regardless of whether or not they are on a call.
There are two types of supervisor and emergency assist calls:

- Existing call - Consultative Conference
- No call

**Note:** Blind Conference is not supported for Emergency and Supervisor Assist.

### About Configuring Supervisor Features

**Note:** If you use Cisco Agent Desktop (CAD), you must configure the supervisor in ICM/IPCC software first, then configure the supervisory features using Cisco Desktop Administrator.

The IPCC Enterprise Supervisor Desktop includes functions that allow supervisors to monitor and manage their agent team members. A supervisor desktop application has all of the capabilities of an agent desktop application plus supervisor services to monitor and manage agent team members. The desktop application supports the Barge-In and Intercept call monitoring features.

**Note:** Refer to the *Reporting Guide for Cisco IPCC Enterprise & Hosted Editions* for information on setting up IPCC Enterprise supervisory features. These instructions help ensure successful use of these features and accurate reporting. See *How to Create an Agent Supervisor (page 31)* for information about configuring supervisor features.

### Barge-in

When using the CTI OS Desktop to barge in on an agent’s call, a supervisor needs to select an agent from the Team State Information grid and select a call from the Monitored Calls section. The supervisor can select a call in this window and then click the **Barge-In** button. The supervisor then becomes party to the call. The supervisor must be in the Not Ready state to use the barge-in function.

When using Cisco Supervisor Desktop (C.D.), an agent supervisor can use the barge-in function while in the Ready or Not Ready state.

C.D. does not allow barge-in when the agent is:

- On hold
- On two calls
- On a conference call
- The C.D. self is on another call
- An IP Phone agent
Intercept

When using the CTI OS Desktop, the Intercept button can only be used after barge-in. The supervisor can use the Intercept button to remove the agent from the call, leaving only the supervisor and the customer on the call.

When using C.D., an agent supervisor can intercept an agent’s call without using Barge-In.

C.D. does not allow intercept when the agent is:

- On hold
- On two calls
- The C.D. self is on another call
- An IP Phone agent

About the Cisco IPCC Enterprise Agent Re-skilling Tool

The IPCC Enterprise Agent Re-skilling Tool is an optional, browser-based application designed for use by IPCC call center supervisors. It lets you change the skill group designations of agents on your team, and quickly view skill group members and details on individual agents. Changes made to an agent's skill group membership take place immediately without the need for the agent to exit and re-enter the system.

Note:

- If an agent is currently in a call, a change to the agent's skill group membership takes place after the call has terminated.
- The Agent Re-skilling Tool is an optional tool and must be installed for you to take advantage of these features.

Modifying the Skill Groups Per Agent Limit

ICM and IPCC impose a default limit on the number of skill groups that can be assigned to a single agent. Once this limit is reached, additional skill groups cannot be assigned. The default limit is specified in the IPCC Enterprise Solutions Reference Network Design Guide (SRND). The limit considers the total of both skill groups and sub-skill groups.

If desired, you can use the ConfigLimit Tool to specify your own limit on the number of skill groups that can be assigned to an agent. For optimum performance, you can specify a limit far lower than the system default (refer to the SRND for performance considerations in choosing a skill groups per agent limit).
Warning: You can also use the ConfigLimit tool to exceed the system default. Exceeding the default value for skill groups per agent can adversely affect system performance. Cisco will not support configurations that exceed the default value.

Using the ConfigLimit Tool

The ConfigLimit tool is a command-line tool utility from the bin directory of all ICM/IPCC Admin Workstations. Access is limited to users with privileges for the Setup or Config Groups in Active Directory for the chosen customer instance.

To change the skill groups per agent limit in configlimit.exe:

Step 1 Launch a command line window on any Admin Workstation.
Step 2 Enter configlimit
Step 3 Optionally, enter cl /show to view the existing limit.
Step 4 To change the limit, enter cl /id 1 value/<new_value> /update
Example: cl /id 1 value/5 /update
Step 5 Press Enter.

Additional Requirements

Lowering the Limit

If you have modified the skill groups per agent limit to be lower than the system default, no additional changes are necessary. The new, lower limit will be enforced immediately. Note that the new limit will NOT impact agents whose existing skill group membership exceeds the new limit until you next attempt to add a new skill group for those agents. At that time the new limit will be enforced, preventing you from adding additional skill groups.

Exceeding the Default Limit

If you have modified the skill groups per agent limit to be higher than the system default, certain deployments will require the following additional changes to your system to use the new limit:

IPCC Gateway PG:

For IPCC Gateway deployments, modify the following registry keys on your IPCC Gateway PGs to include the new value. A change to the registry will require that the PG service be restarted.

ACMI IPCC PIM (IPCC Enterprise Child) HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems, Inc.\ICM\< customer_instance \>\PG{n}[A|B]\PG\CurrentVersion\PIMS\pim{m}\ACMIData\Config\MaxSkills
ERI PG:

For ERI deployments, modify the following registry key on your ERI PGs to include the new value. A change to the registry will require that the PG service be restarted.

ER Service PIM HKEY_LOCAL_MACHINE\SOFTWARE\Cisco Systems, Inc.\ICM< customer_instance >\PG{n}[A|B]\PG\CurrentVersion\PIMS\pim{n}\ERSData\Config\MaxSkills

About Network Transfer for IVRs

When a call is transferred from an IVR (for example, IP IVR) to an agent and that agent wants to transfer the call to another agent, the transfer can be made either from the agent’s IP phone or the agent desktop.

Transfers made from the:

- IP phone are made using CTI route points that point to an ICM/IPCC script.
- Agent desktop are made using the Dialed Number Plan.

For network transfer from either the IP phone or the CTI Toolkit Agent Desktop (Win32), you must queue the call to the skill group in the first ICM/IPCC script; for example, “NetXfer1,” to create the call context. In this script, the “networkTransferEnabled” flag must be set to “1.”

About IPCC Enterprise Routing

To understand how IPCC Enterprise routes voice call, you must understand the concepts of routing operation and routing configuration.

About Routing Operation

To understand how IPCC Enterprise routing occurs, you must understand these concepts:

- **The Routing Client**: The IPCC Enterprise component that submits a route request to the Central Controller.

  In IPCC Enterprise configurations, the routing client can be:
  - The Unified CM PG or System IPCC Agent/IVR Controller
  - An interexchange carrier (IXC)
– A VRU PG
– A Media Routing Peripheral Gateway (for Cisco Collaboration Server and Cisco E-Mail Manager contacts)

Essentially, when a routing client makes a request for a route from the ICM/IPCC platform, it receives the response and delivers the call to the specified destination. If an IPCC Enterprise agent is available, ICM/IPCC software routes the call to the device target (phone) on the Unified CM (device targets are dynamically associated with the agent when the agent logs in to the system). If an agent is not available, ICM/IPCC software can be configured to queue the call to IP IVR or CVP.

- **Route and Queuing Requests:** Messages sent from the routing client to the Central Controller. Route requests typically pass along call detail information about the incoming call. ICM/IPCC software uses information in the route request to determine which routing script will be run for the call.

  Call detail information sent with the route request can include:
  - Dialed Number
  - Calling line ID
  - Caller Entered Digits

  Queueing requests are messages sent from the VRU using the Cisco Service Control Interface. The VRU makes a queue request to provide announcements or music when no IPCC Enterprise agents are available to take the call.

- **About Routing to the VRU with IPCC Enterprise:** With IPCC Enterprise you can ensure that voice calls are routed to the VRU when an agent is not immediately available. The call is queued to the VRU and is be sent to the next available agent via the routing script.

  The configurations for routing to a VRU in an IPCC Enterprise environment include:
  - Translation Route to the VRU via a route on the PG. The Unified CM uses the DNIS in the translation route to direct the call to the VRU.
  - A network route request is issued by the carrier via the NIC. The DNIS and/or Correlation ID is retrieved from the carrier.
  - The call is sent directly to the VRU, so that caller entered digits (CED) can be collected.

  You do not need a translation route to a Unified CM PG since it is targeting agents and implicitly matches call data.

- **Routing a Call to the VRU:** Translation routing is the preferred method of routing a call to the VRU. The DNIS used in the translation route is not the original number dialed by the customer, but rather, the Dialed Number used to route the call to the VRU.
The scenario is as follows:

.a Call comes in to the Unified CM.

.b Unified CM identifies the number as a route point for the Unified CM PG.

.c The Unified CM PG receives a route request from the Unified CM and forwards it to the ICM CallRouter.

.d The ICM CallRouter runs the script for the translation route to the VRU.

.e A Label is returned to the Unified CM via the Unified CM PG.

.f The Unified CM routes the call to the VRU, based on the CTI route point for the translation route.

.g VRU sends up a request instruction with the DN as the DNIS.

.h VRU PG matches up the call and the Correlation ID, then informs the ICM CallRouter of the call arrival with a “request instruction.”

.i The ICM CallRouter matches the correlation ID and finds the pending script/call.

.j The ICM CallRouter continues with script (for example, run script).

For translation routing, the VRU Type to configure in the Network VRU in the ICM/IPCC Administration User Interface is type 2.

Be sure the Unified CM PG routing client and the VRU PG routing client both have the labels mapped for the peripheral targets in the translation route.

About Routing Configuration

To set up routing in your IPCC Enterprise system, you must set up the following entities:

- **Dialed Numbers**: The dialed number is the number that the caller dials to contact an agent. It is sent as part of the call detail information in the route request message sent from the routing client.

  In ICM software, you set up a Dialed Number List. It identifies all of the phone numbers in your contact center that customers can dial to initiate contact.

  **Note**: System IPCC does not support Dialed Number Lists. Instead, it only uses dialed numbers.

  The Dialed Number plays an integral role in routing calls. Dialed Numbers are required pieces of ICM Call types that are used to identify the appropriate routing script for each call.

- **Call Types**: A call type is a category of incoming ICM routable tasks. Each call type has a schedule that determines which routing script or scripts are active for that call type at any time. There are two classes of call types: voice (phone calls) and non-voice (for example,
e-mail and text chat). Voice call types are categorized by the dialed number (DN), the caller-entered digits (CED) and the calling line ID (CLID). Non voice call types are categorized by the Script Type Selector, Application String 1, and Application String 2. In either case, the last two categories of the call type can be optional. For voice call types, the caller-entered digits and the calling line ID can be optional, depending on the call. For non voice call types, Application String 1 and Application String 2 can be optional, depending on the application.

Because the call type determines which routing script is run for a call, the call type defines call treatment in an IPCC Enterprise system. Therefore, the call type is the highest level reporting entity. Reporting on call type activity provides insight into end-to-end customer interactions with the system and with agents by providing data such as service level adherence, transfers, average speed of answer, calls handled, and calls abandoned.

In routing scripts, such as scripts for Self-Service VRU applications, you may change the call type at specific points in the script to indicate that a transaction has been completed. For example, if the customer is calling a bank and successfully checks his or her account balance using a Self-Service script, you may want to change the call type to indicate that the account balance transaction has completed and a new transaction has begun.

You can also change the call type in a script to invoke a new routing script associated with that call type. For example, if a call is not answered at an agent's desktop, you can change the call type in the script to redirect the call to a different script designed for Redirection on No Answer. The Redirection on No Answer script assigns a different agent to handle the call.

• **Routes:** ICM/IPCC software uses routes to define the mapping of a target to a specific label for a routing script. Targets include services (service targets), skill groups (skill targets), agents (device targets), and translation routes.

Routes must be defined for VRU Translation Routing and to route calls to agents.

• **Device Targets:** A device target is a telephony device that can be uniquely addressed (or identified) by a telephone number. A device target is not associated with any one peripheral. Each device target must have one or more labels associated with it, although only one label may exist per routing client.

You *do not* need to use device targets when configuring IPCC Enterprise using the IPCC Enterprise Web Administration Tool. If you *are not* using the IPCC Enterprise Web Administration Tool and you are configuring a System IPCC PG, you *must* use device targets.

**Note:** Device targets and agents are separate entities. A device target is a separately addressable device and is not exclusively owned by any particular agent. Device targets are dynamically associated with Unified CM PG agents for the duration of a log in session.

Each Unified CM PG telephony device that is used by an agent must be configured in the ICM database as a device target.

• **Labels:** A label is the value that ICM/IPCC software returns to a routing client instructing it where to send the call. The routing client can map the label to an announcement, a trunk group and DNIS, or a device target. Special labels might instruct the routing client to take another action, such as playing a busy signal or an unanswered ring to the caller.
If the label is for a device target, the routing client is responsible for delivering the call to the device target on the Unified CM through the voice gateway.

If the label is for a VRU queue point, the routing client delivers the call to the Route Point on the VRU. The VRU must recognize that the call has arrived and then request queue instructions from ICM/IPCC software. ICM/IPCC software returns either a destination for the call or instructions on what script the VRU will run, based on a particular Call Type.

**Note:** Labels are not used with System IPCC.

- **Services:** You set up Services in ICM/IPCC software to represent the type of processing that a caller requires, and to configure VRU Services to route calls to the VRU. For example, separate services might be defined for Sales, Support, or Accounts Payable. A Service is often associated with a peripheral and can be referred to as a Peripheral Service.

For Services that are used to route a call to an agent, must be associated with skill groups. You associate different Skill Groups with Services by making them members of the Service. Using Services allows you to group agents working in like skill groups.

**Note:** Services are not used with System IPCC.

- **Skill Groups:** Agents must be associated with skill groups to receive ICM-routed calls. You create skill groups using the ICM/IPCC Administration User Interface.

ICM/IPCC software allows you to configure two types of skill groups:

- **Base skill group:** The main skill group created using the ICM/IPCC Administration User Interface. Using base skill groups ensures accurate agent reporting and simplifies configuration and scripting for your contact center.

- **Subskill group:** A subdivision of the base skill group. Subskill groups are optional; Cisco recommends not using subskill groups for IPCC Enterprise configurations.

**Note:** Subskill groups are not supported in System IPCC.

For IPCC Enterprise systems, we recommend that you configure base skill groups only. To avoid confusion in reporting and scripting, do not configure sub-skill groups.

**Note:** Subskill groups are not supported for non-voice skill groups. That is, you cannot create subskill groups for these media classes: Single-session chat, Multi-session chat, Blended Collaboration, and E-Mail.

- **About Subskill Groups:** Each time you create a skill group, a base skill group is created by default. If you choose to use subskill groups, you must enable the sub group mask. You can enable this mask either at the peripheral level, or at the individual skill group level. Enabling the subgroup mask at the peripheral level, two subskill groups are automatically created each time you create a skill group.

These subskill groups are named as follows:

- `<base skill group name>.pri`
– `<base skill group name> .sec`

The .pri and .sec suffixes here indicate primary and secondary. The system generates these suffixes because subskill groups are often used so that the skill can be assigned to some agents as a primary skill, and to others as a secondary skill. Note, however, that primary and secondary skill groups do not, by themselves, affect the priority given to them in an ICM routing script.

If you want to use subskill groups as primary and secondary skill groups, understand that primary and secondary skills alone do not guarantee routing priority. You must build that priority into your routing scripts. You can do so by including separate Queue-to-Skill Group nodes in your routing script, and placing the node that points to the primary skill group before the node that points to the secondary skill group.

**Note:** If you have subskill groups configured, be aware that agent reports do not report on base skill groups.

• **Migrating from Subskill Groups to Base Skill Groups:**

If you are upgrading from a previous ICM release and want to migrate from subskill groups to base skill groups, follow these steps:

– Disable the subskill group mask for the peripheral using the PG Explorer tool. All skill groups created after this is done are base-only skill groups; subskill groups are not created by default.

– Define new base skill groups that correspond to your subskill groups. Assign agents to the new base skill groups and remove them from your subskill groups.

– Update all of your routing scripts, so that they no longer refer to the subskill groups, and refer only to the base skill groups.

**Note:** Be sure to be consistent in your use of skill groups in your routing scripts. When using base skill groups, be sure to refer to only base skill groups in your routing scripts. If you choose to use subskill groups (not recommended), be sure to refer to only subskill groups in your routing scripts.

**About Routing Scripts**

A routing script, created using the Script Editor, identifies the desired agent based upon skills and customer database profile, determines the call target, and returns a route response to the routing client.
Chapter 3

Routing Tasks for Multichannel Options

If you have installed multichannel features with Cisco IPCC Enterprise, it is important that you understand how ICM/IPCC software routes contacts and requests made from the Cisco Collaboration Server and the Cisco E-Mail Manager server.

This chapter contains the following topics:

- Configuring ICM/IPCC software for Multichannel Routing, page 27
- Configuring Multichannel Software, page 28

Configuring ICM/IPCC software for Multichannel Routing

To route contact requests submitted from the World Wide Web or E-Mail, you must have configured:

- Media Routing Peripheral Gateway
- Media Routing Domains and Media Classes
- Multichannel agents
- Application instances
- Administration connections
- Multichannel skill groups
- Multichannel routing scripts
Configuring Multichannel Software

See Also

For information on configuring IPCC Enterprise for multichannel routing, refer to the *IPCC Installation and Configuration Guide for Cisco IPCC Enterprise Edition*.

Configuring Multichannel Software

When your ICM/IPCC configuration is complete, you must configure your ICM multichannel software.

For Web Collaboration Option, you must configure:

- Cisco Media Blender
- Cisco Collaboration Server

For E-Mail requests, you must configure Cisco E-Mail Manager.

See Also


For information on configuring the Cisco Media Blender component of the Web Collaboration Option, refer to the *Cisco Media Blender Installation Guide for Cisco ICM/IPCC Enterprise & Hosted Editions* and the *Cisco Media Blender Administration Guide for Cisco ICM/IPCC Enterprise & Hosted Editions*.

For information on configuring the E-Mail Manager option, refer to the *Cisco E-Mail Manager Installation and Configuration Guide for Cisco ICM/IPCC Enterprise & Hosted Editions*. 
Part 2: Performing Administrative Tasks with Cisco IPCC Enterprise

The following sections describe the configuration required for setting up IPCC Enterprise agents and agent features. These sections also provide information on setting up voice and multichannel routing with IPCC Enterprise.

**Note:** If you choose to upgrade Unified CM, you need to update the Java Telephony API (JTAPI) client on the Unified CM PG and then restart the PG. If you perform Unified CM maintenance that involves configuration changes only, the Unified CM PG does not require restart. Refer to the *Cisco Customer Response Solutions Administration Guide* for detailed information about updating the JTAPI Client.
Chapter 4

Administering Agents

This chapter explains the tasks you must be familiar with when setting up agents for your IPCC Enterprise contact center.

This chapter contains the following topics:

- How to Administer Agents, page 31
- How to Configure Not Ready Reason Codes, page 35
- How to Configure Agent Features, page 36
- How to Configure Supervisor Features, page 40
- Using the IPCC Enterprise Agent Re-skilling Tool, page 41
- Configuring Network Transfer for IVRs, page 42

How to Administer Agents

How to Create IPCC Enterprise Voice-Only Agents

**Note:** You must ensure that you have already set up Agent Desk Settings before configuring agents.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Use the Agent Explorer tool in the ICM Configuration Manager to create an agent record. If you want to associate this agent with an existing Person record, click the Select Person button.</td>
<td>Creates an agent record associated with the person record.</td>
</tr>
<tr>
<td></td>
<td><strong>Example:</strong></td>
<td></td>
</tr>
</tbody>
</table>

**Note:** Important! Do not change an agent’s ID while the agent is logged into the CTI Toolkit Agent Desktop (Win32).

Enter the agent information and click **Save** to save the record. See the online help for more information.
How to Administer Agents

**How to Administer Agents**

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>ICM Configuration Manager &gt; Tools &gt; Explorer Tools &gt; Agent Explorer</td>
<td>Note: Agent IDs can be up to nine digits long. The first digit in the ID must be 1 through 9. It cannot be 0. Also, this number cannot be the same as the extensions on the CCM cluster for this agent.</td>
</tr>
<tr>
<td>2</td>
<td>Click Save.</td>
<td>Creates the Agent record. If you did not use the Select Person button to associate the agent with an existing Person record, a new Person record is automatically created for the agent.</td>
</tr>
</tbody>
</table>

**Note:** You can also add many agents at one time using the Bulk Configuration tool.

**How to Delete IPCC Enterprise Voice-Only Agents**

You logically delete agents using the Agent Explorer tool. Agents cannot be deleted from the Agent Explorer until they have been removed from any teams using the Agent Team List tool. If agents exist in script references, use the Script Reference tool to find any existing references, then use the ICM Script Editor application to delete that script. Agents still exist in the deleted objects databases until permanently deleted.

**Note:** For scripting and reporting purposes, if the script is configured to send a call directly to an agent and that agent is permanently deleted, the call/script would fail. Also, you can run historical reports for permanently deleted agents.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Delete the agent record. Use the Agent Explorer tool in the ICM Configuration Manager to delete the agent record. Highlight the agent and click Delete. <strong>Note:</strong> If this was the last or only agent record associated with the person record for this agent, then the associated person record is also deleted. Example: ICM Configuration Manager &gt; Tools &gt; Explorer Tools &gt; Agent Explorer</td>
<td>Deletes the agent as well as the associated person.</td>
</tr>
<tr>
<td>2</td>
<td>Purge the agent from the deleted objects. Highlight the Agent table name in the Tables with Deleted Records window, then highlight the agent in the Deleted Records of the “Agent” Table window. Click Delete. Example:</td>
<td>Permanently deletes the agent from the database.</td>
</tr>
</tbody>
</table>
How to Create an Agent Supervisor

You create an agent supervisor by simply modifying the agent record in the ICM Configuration Manager.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Select the Supervisor tab in the Agent Explorer tool application when creating or modifying an agent record.</td>
<td>Accesses an agent record.</td>
</tr>
<tr>
<td>2</td>
<td>Check the <strong>Supervisor Agent</strong> check box. Enter the Windows Domain name.</td>
<td>Designates the agent as a supervisor. Complete the remaining fields on this tab as described in the ICM Configuration Manager online help.</td>
</tr>
</tbody>
</table>

**Note: Important!** You must perform the configuration listed above so the supervisor can use the Barge-In and Intercept features.

How to Delete an Agent Supervisor

You delete an agent supervisor by simply modifying the agent record in the ICM Configuration Manager.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Select the Supervisor tab in the Agent Explorer tool application when deleting an agent record.</td>
<td>Accesses an agent record.</td>
</tr>
<tr>
<td>2</td>
<td>Uncheck the <strong>Supervisor Agent</strong> check box.</td>
<td>Agent is no longer designated as a supervisor. <strong>Note:</strong> If you want to delete the entire record, follow the guidelines for deleting an agent record in the “How to Delete IPCC Enterprise Voice-Only Agents” section.</td>
</tr>
</tbody>
</table>

How to Create Agent Teams

After adding agents with the Agent Explorer tool, you can create agent teams with the Agent Team List tool.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Access the Agent Team List tool in the ICM Configuration Manager.</td>
<td>Access the Agent Team List tool.</td>
</tr>
</tbody>
</table>
### How to Administer Agents

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Access the Agent Team List tool in the ICM Configuration Manager</td>
<td>Opens the Agent Team List tool.</td>
</tr>
<tr>
<td>2</td>
<td>Click <strong>Retrieve</strong> to obtain the current list of teams.</td>
<td>Displays the current teams.</td>
</tr>
<tr>
<td>3</td>
<td>Highlight the team you want to delete and click <strong>Delete</strong>.</td>
<td>Deletes the agent team.</td>
</tr>
<tr>
<td>4</td>
<td>Click <strong>Save</strong> to save your changes.</td>
<td>Saves your changes to the database.</td>
</tr>
</tbody>
</table>

#### How to Create Multichannel Agents

Create multichannel agents using the Administration desktops of the multichannel software. Detailed information on creating agents using Cisco Collaboration Server and/or Cisco E-Mail manager appears in the associated documentation.

#### How to Delete Multichannel Agents

Delete multichannel agents using the Administration desktops of the multichannel software. The agent will be deleted in each of the applications in which the agent is enabled before being deleted on ICM software. Detailed information on deleting agents using Cisco Collaboration Server and/or Cisco E-Mail Manager appears in the associated documentation.

If you choose to delete multichannel agents using the ICM Configuration Manager, the ICM software displays an error message. It is recommended that you delete the agent from the application, and run the Verify and Synch tools for the multichannel application.
### How to Configure Not Ready Reason Codes

<table>
<thead>
<tr>
<th>Step</th>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>In the ICM Configuration Manager, configure Not Ready reason codes</td>
<td>Configure the agent Not Ready reason codes in the Reason Code List tool. &lt;br&gt;<strong>Note:</strong> If you are using the CTI Toolkit Agent Desktop (Win32), make sure the reason codes match the codes on the desktop. ICM reason codes display in the Agent Not Ready reports, but the agent actually selects the desktop code, so these codes must match to avoid confusion. Configure predefined Not Ready reason codes so their text displays in the reports.</td>
</tr>
<tr>
<td></td>
<td><strong>Example:</strong>&lt;br&gt;&lt;br&gt;<strong>ICM Configuration Manager &gt; Tools &gt; List Tools &gt; Reason Code List</strong></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>In the ICM Configuration Manager, enable the Agent event detail option.</td>
<td>Open the PG Explorer tool, select the PG, and select the Cisco Unified CM peripheral. Then check the Agent event detail check box on the Agent Distribution tab to enable reporting on Not Ready reason codes.</td>
</tr>
<tr>
<td></td>
<td><strong>Example:</strong></td>
<td></td>
</tr>
</tbody>
</table>

See Also

For information about the ICM Configuration Manager, refer to the ICM Configuration Manager online help.

For information about agent features, see Configuring CTI OS and CAD Desktop Features (page 13).

For information about supervisor features, see About Configuring Supervisor Features (page 18).

For information about bulk loading agents, refer to the IPCC Installation and Configuration Guide for Cisco IPCC Enterprise Edition.


For information about database verify and sync, refer to the Cisco Collaboration Server Administration Guide for Cisco ICM/IPCC Enterprise & Hosted Editions and online help.
How to Configure Agent Features

<table>
<thead>
<tr>
<th>Step</th>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>3</td>
<td>Configure the Not Ready reason codes on the desktop.</td>
<td></td>
</tr>
</tbody>
</table>

See Also

For information about configuring CTI OS Logout and Not Ready reason codes, refer the CTI OS System Manager's Guide for Cisco ICM/IPCC Enterprise & Hosted Editions.

How to Configure Agent Features

This section describes how to perform the following tasks:

- Configure IPCC Enterprise for Redirection on No Answer situations on IP IVR and CVP
- Configure automatic wrap-up
- Configure supervisor assist and emergency alert situations

How to Configure IPCC Enterprise for Redirection on No Answer Situations on IP IVR

Note: Important! Unified CM is the ICM Routing Client that ensures the call arrives at the right destination.

Recommended configuration for Redirection on No Answer situations is detailed in the table below:

<table>
<thead>
<tr>
<th>Step</th>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
</table>
| 1    | In the ICM Configuration Manager, configure Agent Desk Settings | Allows you to define the following:  
  - A Redirection on No Answer time  
  - Redirection on No Answer dialed number (to access the Redirection on No Answer script defined in Step 3, below)  
  Note: The Redirection on No Answer timer is not applicable if Auto-answer is enabled since the Redirection on No Answer feature and Force Answer are mutually exclusive. If both are defined, Auto-answer takes precedence over Redirection on No Answer. |
|      | Example:          |         |
|      | ICM Configuration Manager > Tools > List Tools > Agent Desk Settings List |         |
| 2    | In the ICM Configuration Manager, set up the call type | Set up the call type and associate it with the dialed number and the routing script. |
|      | Example:          |         |
### How to Configure Agent Features

<table>
<thead>
<tr>
<th>Step</th>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
</table>
| 3    | Using the ICM Script Editor, create a routing script to handle Redirection on No Answer situations. | Allows you to define routing logic used for situations when an assigned agent does not answer.  

**Note: Important!** This script queues the call at the highest priority in the skill group(s) defined within the call variables. Otherwise, the call is no longer the first in queue, as it was when it was first assigned to the (unavailable) agent. Also, call variables that were set in the original routing script are still present in the ring-no-answer script. Consequently, you might want to set variable values in one script that can be checked and acted upon in the other script.

---

**How to Configure IPCC Enterprise for Redirection on No Answer Situations on CVP**

For IPCC Enterprise systems in which CVP is deployed, the Unified CM does not control CVP and cannot send an unanswered call back to CVP for re-queuing. You configure the Re-route on Redirection on No Answer feature to only make the agent state “Not Ready” when the agent does not answer a call; you can use the CVP Target Requery feature to re-queue the call. Refer to the *IPCC Installation and Configuration Guide for Cisco IPCC Enterprise Edition* for more details.

**Note: Important!** Unified CM does not control the queuing platform (CVP); therefore, Unified CM can not send the call back to CVP for re-queuing.

Recommended configuration for Redirection on No Answer situations is detailed in the table below:

<table>
<thead>
<tr>
<th>Step</th>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
</table>
| 1    | In the ICM Configuration Manager, configure Agent Desk Setting                    | Allows you to define the following:  

- A Redirection on No Answer time: Set this number less than the number set for the No Answer Timeout for the Target Requery that you set in CVP (causes agent to be made unavailable after the Redirection on No Answer).
<table>
<thead>
<tr>
<th>Step</th>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
</table>
| 1    | ICM Configuration Manager > Tools > List Tools > Agent Desk Settings List | Answer timer expires, but will not invoke the Redirection on No Answer mechanism to re-route the call—see Step 3, below)  
• Redirection on No Answer dialed number (to access the Redirection on No Answer script): Leave this field blank |
| 2    | Using the CVP VBAdmin tool, configure the CVP ring-no-answer timeout value. | This step causes CVP to issue a requery to ICM software if the assigned agent does not answer. In the VBAdmin tool, use the SetRNATimeout command to set the ring-no-answer timeout to a duration that is two seconds longer than the Redirection on No Answer time that was set in Step 1.  
Note: Set this timeout to under 30 seconds since ICM software waits 30 seconds for CVP to return a routing label and then fails, so CVP needs to requery before this happens. |
| 3    | Using the ICM Script Editor, account for requeries in the routing script to handle Redirection on No Answer situations.   
Use the Target Requery script feature.  
Note: Do not create and schedule a new Routing script for Redirection on No Answer purposes in CVP deployments. | Allows you to report on Redirection on No Answer information. This script enables Requery (enable the Requery check box) on the node in the script that selects and delivers the call to the first agent. Depending on the type of node used, the Requery mechanism selects a new target from the available agents or requires additional scripting.  
Refer to the *ICM Scripting and Media Routing Guide for Cisco ICM/IPCC Enterprise & Hosted Editions* for information on how Requery works for the different nodes.  
Note: Important! This script queues the call at the highest priority in the skill group(s) defined within the call variables. Otherwise, the call is no longer the first in queue, as it was when it was first assigned to the (unavailable) agent. |

**Note:**  
- If you configure the Redirection on No Answer timer in the ICM Agent Desk Settings, it is not necessary to configure the Unified CM Call Forward No Answer fields for the agent extensions in the Unified CM configuration. If you would like to configure them for cases when an agent is not logged in, set the Unified CM system service parameter for Unified CM Call Forward No Answer timer at least 3 seconds higher than the ICM Redirection on No Answer timer on each of the Unified CM nodes.  
- If you want to ensure that Redirection on No Answer calls adversely affect the service level, define the service level threshold to be less than the Redirection on No Answer timer at the call type and service.
How to Configure Automatic Wrap-Up

<table>
<thead>
<tr>
<th>Step</th>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
</table>
| 1    | Configure Agent Desk Settings to require automatic wrap-up | Allows you to force agents into Wrap-up mode when they are finished with inbound or outbound calls. Use these two fields to enable automatic wrap-up:  
- Work mode on Incoming  
- Work mode on outgoing  
Choose either Required or Required with wrap-up data to indicate automatic wrap-up. Also, enter the time, in seconds, allocated to an agent to wrap-up a call. |
| 2    | Configure Agent Desk Settings to require appropriate reason codes. | Allows you to determine when and if agents are required to enter a Reason Code when they log out or enter a Not Ready state. |

How to Configure Supervisor Assist and Emergency Alert Situations

Recommended configuration for supervisor assist and emergency alert situations is detailed in the table below:

<table>
<thead>
<tr>
<th>Step</th>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
</table>
| 1    | In the ICM Configuration Manager, configure Agent Desk Settings | Allows you to define the following:  
- Assist call method  
- Emergency alert method |
| Example: | | |
| ICM Configuration Manager > Tools > List Tools > Agent Desk Settings List | |
| 2    | In the ICM Configuration Manager, set up the call type | Set up the call type and associate it with the dialed number and the routing script. |
| Example: | | |
| ICM Configuration Manager > Tools > List Tools > Call Type List | |
| 3    | In the ICM Configuration Manager, configure Dialed Number for supervisor | Allows you to define the following:  
- Dialed number string  
- Call type |
| Example: | | |
| ICM Configuration Manager > Tools > List Tools > Dialed Number/Script Selector List | |
How to Configure Supervisor Features

This section explains how to configure supervisor logged-in state for CAD.

How to Configure Supervisor Logged-in State for CAD

<table>
<thead>
<tr>
<th>Step</th>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>In the ICM Configuration Manager, configure Agent Desk Settings for the CAD supervisor.</td>
<td>Create separate desk settings for the CAD supervisor.</td>
</tr>
<tr>
<td></td>
<td><strong>Example:</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>ICM Configuration Manager &gt; Tools &gt; List Tools &gt; Agent Desk Settings List</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Leave Logout non-activity time option blank</td>
<td>Leaving this option blank keeps a supervisor logged into Cisco Agent Desktop.</td>
</tr>
<tr>
<td></td>
<td>A CAD supervisor uses Cisco Supervisor Desktop to view agent activity, silently monitor, record agent calls, send Team</td>
<td></td>
</tr>
</tbody>
</table>
Purpose

Performance Messages, and chat with agents and other supervisors. A supervisor can only barge in, intercept, or view skill statistics if Cisco Agent Desktop is running on the supervisor's computer.

See Also

For information about Agent Desk Settings, refer to the IPCC Installation and Configuration Guide for Cisco IPCC Enterprise Edition and the ICM Configuration Manager online help.

For information about Barge-in and Intercept, refer to the CTI OS System Manager's Guide for Cisco ICM/IPCC Enterprise & Hosted Editions.

Using the IPCC Enterprise Agent Re-skilling Tool

Accessing the IPCC Enterprise Agent Re-skilling Tool

Access to the Agent Re-skilling Tool is limited to individuals with supervisor privileges.

**Note:** This tool is accessible using System IPCC Enterprise or within IPCC Enterprise.

To access the Agent Re-skilling Tool using your agent name:

1. In your browser's address bar, enter: **https://<agent_reskilling_server_ip_or_dns>/reskill**
   
   Your administrator must provide you with this address.

2. Press **Enter**. The Login page displays.

3. Enter your supervisor username and password.

   **Note:** As of version 7.2, in a System IPCC Enterprise system, the login name to the Agent Re-skilling tool is **NOT case sensitive**. In an IPCC Enterprise system, the login name to the Agent Re-skilling tool **may or may not be case sensitive**. This is determined by the "Login case sensitive" value in the System Information screen under Miscellaneous Tools in the ICM Configuration Manager.

4. Click **Login**.

In certain deployments, you might also have the option of logging into the Agent Re-skilling Tool using your numeric agent ID. To log in using your agent ID:

1. In your browser's address bar, enter: **https://<agent_reskilling_server_ip_or_dns>/reskill**

   Your administrator must provide you with this address.
2. Press **Enter**. The Login page displays.

3. Click the **Login By Agent ID** link.

   **Note:** If this link does not appear on the Login Page you can only log in using your login name.

4. Enter your numeric agent ID and password.

5. Select the correct peripheral for your agent ID. Consult your administrator if you are not sure of your correct peripheral.

6. Click **Login**.

For security purposes, log out when you are finished using the Agent Re-skilling Tool. Click the **Log Out** link at the top-right of the page. This action returns you to the Login page. Sessions also time-out automatically after 30 minutes of inactivity. If your session has ended due to inactivity, you are prompted to login again to resume using the tool.

**See Also**

For detailed information about using the Cisco IPCC Enterprise Agent Re-skilling tool, refer to the online help.

### Configuring Network Transfer for IVRs

#### How to Configure Network Transfer from an IP Phone

To configure network transfer from an IP Phone, complete the following steps:

1. Define a CTI Route Point, for example “9999,” in the Unified CM. Associate it with the JTAPI User that is connected to IPCC PIM in ICM software.

2. In the ICM Admin Workstation, define a Dialed Number for IPCC PIM and a call type for that dialed number. This call type can then be associated with a ICM script; for example, “NetXfer2.”

   **Note:** Do not define the labels of agents for the Unified CM PG. Instead, define the labels for the VRU PIM so that the route result is returned to VRU instead of a Unified CM PG. If you do define the agent labels for the Unified CM PG, the ICM Router returns the route result to the VRU PIM, if “Network Transfer Preferred” is enabled on the Unified CM PG and VRU PIM and returns the route result to the Unified CM PG if “Network Transfer Preferred” is disabled on the Unified CM PG and VRU PIM.

3. When the call is delivered to Agent 1 using the ICM Script “NetXfer1,” the agent can dial the number 9999 to send the call to another script, “NetXfer2.”
How to Configure Network Transfer from a CTI OS Desktop

To configure network transfer from a CTI OS Desktop, complete the following steps:

1. Define a “Dialed Number Plan” in ICM software. The routing client is the IPCC PIM and the dialed number is the one defined before for the IPCC PIM (that is, IPCC_PIM.9999).

2. Set the Post Route to Yes and the Plan to International.

3. In the Agent Desk Settings, check all the Outbound access check boxes.
Chapter 5

Routing Voice Calls with IPCC Enterprise

This chapter contains the following topics:

- How to Set Up IPCC Enterprise Voice Routing, page 45
- How to Route to a Target Device with IPCC Enterprise, page 46

How to Set Up IPCC Enterprise Voice Routing

How to Configure a Device Target with IPCC Enterprise

<table>
<thead>
<tr>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Step 1</strong> Add/configure IP Phone on Unified CM.</td>
<td>Creates device.</td>
</tr>
<tr>
<td><strong>Step 2</strong> Create/configure a Device Target on ICM software, being sure to enter the Dialed Number associated with the IP Phone. Use this string when entering the dialed number: /devtype ciscophone/dn 9510.</td>
<td>Ensures that ICM can send this string to the Unified CM to initialize the device.</td>
</tr>
<tr>
<td><strong>Example:</strong> ICM Configuration Manager &gt; Targets &gt; Device Target &gt; Device Target Explorer</td>
<td></td>
</tr>
<tr>
<td><strong>Step 3</strong> Associate the device in Unified CM with the selected Global User.</td>
<td>Maps the user and CTI Route Point.</td>
</tr>
</tbody>
</table>

Setting up Duplicate Extensions in Multi-Site IPCC Enterprise Installations

You can use duplicate extensions in different sites in a multi-site IPCC Enterprise configuration. To accomplish this, you must associate the device targets with the appropriate peripheral using the /PID configuration parameter. This ensures that the device target is tied to the peripheral; other peripherals will not recognize it.
To associate a device target with a peripheral:

- Using the Device Target Explorer, add or modify single device target entries. (Use the Device Target Bulk (Insert) tool when adding a new device.)

- Set the Configuration Parameter field to /PID <xxxx>, where <xxxx> is the four-digit Peripheral ID (that is, /PID 5000). When you save this change, it takes effect immediately. You do not need to cycle the Unified CM PG Node services for this to take effect.

**How to Route to a Target Device with IPCC Enterprise**

The following procedures outline the steps to follow each time you want to route to a new device target in IPCC Enterprise.

**On Unified CM**

<table>
<thead>
<tr>
<th>Step</th>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Create a CTI Route Point on the Unified CM</td>
<td>Configures the Unified CM to make a route request to ICM software when the Route Point is dialed</td>
</tr>
<tr>
<td>2</td>
<td>Associate the CTI Route Point with the PG User</td>
<td>Makes the Route Point visible to ICM software</td>
</tr>
</tbody>
</table>

**Using the ICM Configuration Manager**

<table>
<thead>
<tr>
<th>Step</th>
<th>Command or Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Create a new Dialed Number using the ICM Configuration Manager</td>
<td>Defines a new entry point for call routing</td>
</tr>
<tr>
<td>2</td>
<td>Add a new Call Type using the ICM Configuration Manager</td>
<td>Allows you to categorize calls and route them appropriately</td>
</tr>
<tr>
<td>3</td>
<td>Associate the Dialed Number with the ICM Call Type</td>
<td>Allows you to map the Dialed number to a routing script</td>
</tr>
<tr>
<td>4</td>
<td>Create a new routing script using the ICM Script Editor</td>
<td></td>
</tr>
<tr>
<td>5</td>
<td>Associate the Call Type with the routing script</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** In a Unified CM cluster, be aware that two routing clients must not share the same CTI Route Point. Each routing client must use distinct CTI Route Points in a Unified CM cluster.

**How to Enable Subskill Peripherals and Skill Groups**

You must use only base skill groups for IPCC Enterprise configurations. A default is set at the peripheral level, ensuring that any new skill group created is base-only.
See Also

For more information about creating routing scripts, refer to the *ICM Scripting and Media Routing Guide for Cisco ICM/IPCC Enterprise & Hosted Editions* and the ICM Script Editor online help.

For more information about configuring IPCC Enterprise, refer to the *IPCC Installation and Configuration Guide for Cisco IPCC Enterprise Edition*. 
Chapter 5: Routing Voice Calls with IPCC Enterprise

How to Route to a Target Device with IPCC Enterprise
The Dialed Number Plan

Note: The Dialed Number Plan is only applicable to the Voice media.

This chapter contains the following topics:

• About the Dialed Number Plan, page 49
• About Dialed Number Plan Values, page 50
• How to Configure the Dialed Number Plan, page 54

About the Dialed Number Plan

The Dialed Number Plan allows you to manage and track agent-initiated calls.

Understanding the Dialed Number Plan

The Dialed Number Plan consists of a number of entries intended to accommodate the different types of calls agents might make. Each entry contains a wildcard string that is used to match a number that an agent might dial. Each digit of the string is processed until a matching dial plan entry is found. When found, the selected trunk group or resource is used to complete the call.

Each entry contains additional information to indicate how the calls matching that wildcard string will be handled.

For example, dialing a 9 to receive an outside line on a PBX or ACD would be specified in the dial plan. All patterns that reference network trunks might begin with a ‘9’ digit. Subsequent digits might be ‘1’ for long distance patterns, ‘0’ for operator assisted or international calls, ‘2’ through ‘9’ to specify an area code. The dial plan allows a customer to have multiple phone carrier trunks terminated at the PBX or ACD for different outbound call types. A customer might choose MCI as the long distance carrier while AT&T is the international carrier, and Bell Atlantic is the local carrier. The dial plan configuration would be used to determine which carrier to use based on the patterns defined within the dial plan.
**Note:** Do not confuse the Dialed Number Plan Bulk Insert tool with the Dialed Number Bulk Insert tool.

You use the Dialed Number Plan to:

- Ensure agent-initiated calls are routed by an ICM routing script
- Set up basic dialing substitutions

**Using the Dialed Number Plan to Ensure ICM Routing of Agent Calls**

The most common and powerful use of the Dialed Number Plan is to ensure that agent-initiated calls are routed through ICM software. In this case, you must specify that you want to request a PostRoute for the call and specify a dialed number associated with a routing script designed to handle the type of agent call.

Use this method of configuring the Dialed Number Plan for:

- Agent-to-agent transfers
- Agent-to-agent calling
- Agent-initiated outbound calls

**Using the Dialed Number Plan to Set Up Basic Dialing Substitutions**

You can also use the Dialed Number Plan to specify basic dialing substitutions. In this scenario, you identify a wildcard pattern to match the number dialed by an agent. However, you do not request a Post Route and the call is not matched to a Dialed Number, and thus not routed by ICM software. Instead, you enter the string you want to be dialed in the Dial String field. That string is used to place the agent’s call.

Using the Dialed Number Plan in this way is most useful for setting up such things as:

- Speed Dial
- Using alphanumeric characters to dial from a soft phone

**About Dialed Number Plan Values**

Each field on the Dialed Number Plan dialog box is defined in the ICM Configuration Manager online help. This section provides additional information about these fields and how you can use them to set up agent dialing for your contact center.

The window below illustrates a Dialed Number Plan entry that specifies ICM routing for the agent call:
Wildcard Pattern

The wildcard pattern you enter can contain letters, digits, and number signs (#). It can also include the following wildcard characters:

<table>
<thead>
<tr>
<th>Character</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>?</td>
<td>Represents any single alphanumeric character.</td>
</tr>
<tr>
<td>!</td>
<td>Represents any string of character and can appear only at the end of a pattern.</td>
</tr>
</tbody>
</table>

Routing Client

The Routing Client field lets you specify the routing client for the agent call. In IPCC Enterprise configurations, set this field to identify the Unified CM PG.

Post Route

Use the Post Route field to specify whether this type of agent call will be sent to a routing script. If you set Post Route to YES, you must also enter a Dialed Number that is associated with a routing script designed to handle the type of agent call.

Dialed Number

Use the Dialed Number field if you’ve set the Post Route field to Yes, indicating that you want an ICM routing script to handle this agent call.
Dial String

Use the Dial String field only when you set the Post Route field to No, indicating that you want to use this entry for dialing substitutions. This field cannot be used when PostRoute is selected to send the call to an ICM routing script.

The Dial String field can contain wildcard characters used to translate the dialed number string provided by the agent to the dial string that will be delivered to the switching platform. The following table describes the wildcard characters that might appear in the DialString field.

<table>
<thead>
<tr>
<th>Wildcard Character</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>!</td>
<td>Copy all remaining characters in the agent-provided dialed number string</td>
</tr>
<tr>
<td>?</td>
<td>Copy character at the position identified</td>
</tr>
<tr>
<td>X or x</td>
<td>Excludes the character in the agent supplied dialed number string at the position identified from the offset as defined from the beginning of the DialedNumberPlan DialString field</td>
</tr>
</tbody>
</table>

The following table provides examples of the translation of a DialedNumber string specified by an agent to a resultant DialString as defined by the DialString entry of the matching DialedNumberPlan entry.

<table>
<thead>
<tr>
<th>Agent Dialed Number</th>
<th>DialedNumber Plan Dial String</th>
<th>Dial string result</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>5133</td>
<td>6100</td>
<td>6100</td>
<td>Direct substitution.</td>
</tr>
<tr>
<td>5133</td>
<td>6X???</td>
<td>6133</td>
<td>Partial replacement.</td>
</tr>
<tr>
<td>5133</td>
<td>!</td>
<td>5133</td>
<td>Complete Copy.</td>
</tr>
<tr>
<td>5133</td>
<td>9275!</td>
<td>92755133</td>
<td>Prefix Addition.</td>
</tr>
<tr>
<td>5133</td>
<td>62XX??</td>
<td>6233</td>
<td>First 2 char substitution.</td>
</tr>
<tr>
<td>5133</td>
<td>?? ??</td>
<td>5133</td>
<td>Complete Copy.</td>
</tr>
<tr>
<td>5133</td>
<td>?XXX000</td>
<td>5000</td>
<td>Retain first character; substitute the remaining characters.</td>
</tr>
<tr>
<td>2755100</td>
<td>?? ??200</td>
<td>2755200</td>
<td>Replace last three characters.</td>
</tr>
<tr>
<td>2755100</td>
<td>!220</td>
<td>2755100220</td>
<td>Suffix addition.</td>
</tr>
</tbody>
</table>

Using the Dial String for Speed Dialing

You can configure Static Dial String translations to provide speed dial capabilities. Here, you enter the abbreviated string an agent would dial in the wildcard pattern. You enter the actual target number in the Dial String of the entry.

When a dialed number (provided by an agent) matches the Wildcard pattern of the Dialed Number Plan entry, the Dial String configured entry is sent in place of the agent supplied Dialed Number string.
The following table provides an example of a speed dial configuration.

<table>
<thead>
<tr>
<th>Agent Dialed Number</th>
<th>Dial String</th>
<th>Result</th>
</tr>
</thead>
<tbody>
<tr>
<td>133</td>
<td>919782755133</td>
<td>919782755133</td>
</tr>
</tbody>
</table>

Using the Dial String for Alphanumeric Substitutions

You can use the Dialed Number Plan to allow agents to specify an alphanumeric string when dialing. For instance, an agent might dial “SALES” when calling the sales department rather than a numeric value that might be harder to remember.

To configure an alphanumeric substitution, configure the alphanumeric dial string as the Wildcard pattern and the target number as the Dial String of the DialedNumberPlan entry. When a dialed number provided by an agent matches the wildcard pattern of the Dialed Number Plan entry, the configured Dial String is sent in place of the agent supplied string.

Wildcard characters can be combined with this feature to allow Alpha prefixes to be added to numbers to identify the location of the number. Examples are shown in the following table:

<table>
<thead>
<tr>
<th>Agent Dialed Number</th>
<th>DialedNumberPlan Dial String</th>
<th>Resultant Dial String</th>
</tr>
</thead>
<tbody>
<tr>
<td>SALES</td>
<td>919782755100</td>
<td>919782755100</td>
</tr>
<tr>
<td>BOS5133</td>
<td>9782755133</td>
<td>9782755133</td>
</tr>
<tr>
<td>FL14Office1433</td>
<td>5133</td>
<td>5133</td>
</tr>
</tbody>
</table>

Dial Number Type Plan

The Dial Number Type Plan lets you specify the type of call that will be placed. These include:

<table>
<thead>
<tr>
<th>Dialed Number Plan</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>International</td>
<td>Allows agents to place calls classified as international calls.</td>
</tr>
<tr>
<td>National</td>
<td>Allows agents to place calls classified as national long distance calls.</td>
</tr>
<tr>
<td>Local</td>
<td>Allows agents to place calls classified as national local calls.</td>
</tr>
<tr>
<td>Operator Assisted</td>
<td>Allows agents to place calls classified as operator assisted calls.</td>
</tr>
<tr>
<td>PBX</td>
<td>Allows agents to place calls to agents on the same peripheral.</td>
</tr>
</tbody>
</table>

The options for this field map exactly to the options on the Agent Desk Settings List window. ICM software checks the Agent Desk Settings for the agent placing the outbound call. Agent Desk Settings define which types of calls agents are permitted to make. If the Agent Desk Settings for an agent prevent him or her from placing a particular type of call (for instance, international), the call is not placed.
How to Configure the Dialed Number Plan

How to Use the Dialed Number Plan to Ensure ICM Routing of Agent Calls

Follow these steps to configure a Dialed Number Plan entry to route an agent call through ICM software.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Create a routing script to handle each type of agent-initiated call using the ICM Script Editor.</td>
<td>Ensures agent-initiated calls are routed appropriately by ICM software. The script can target agent, services, or skill groups using ICM script nodes. When a target is chosen, the associated label is sent back to the requesting peripheral. The label value is substituted for the dial string specified by the agent and sent to the switching platform to place the outbound call.</td>
</tr>
<tr>
<td>2</td>
<td>In the ICM Configuration Manager, set up the call type. <strong>Example:</strong> ICM Configuration Manager &gt; Tools &gt; List Tools &gt; Call Type List</td>
<td>Set up the call type and associate it with the dialed number to target to routing scripts. <strong>Note:</strong> You can also use a pre-existing call type and script.</td>
</tr>
</tbody>
</table>
| 3    | Insert an entry in the Dialed Number Plan dialog box. Using the fields in this window, make sure to:  
- Indicate the appropriate Wildcard character.  
- Set the Post Route text box to Yes.  
- Select a valid Dialed Number associated with the routing script used to route the agent call.  
- Set the Dial Number Type Plan to indicate the type of call. **Example:** ICM Configuration Manager > Tools > Bulk Configuration > Insert > Dialed Number Plan Bulk Insert | Matches the agent’s dialed string to a Dialed Number. This ensures the agent’s call will be routed by an ICM routing script. |
| 4    | Ensure Agent Desk Settings are set to identify the types of calls agents can place. **Example:** | Ensures that agents are allowed to or restricted from placing different types of outbound calls. |
How to Use the Dialed Number Plan to Set Up Basic Dialing Substitutions for Agent Calling

Follow these steps to configure a Dialed Number Plan entry to route an agent call through ICM software.

<table>
<thead>
<tr>
<th>Step</th>
<th>Action</th>
<th>Purpose</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Insert an entry in the Dialed Number Plan dialog box. Using the fields in this window, make sure to:</td>
<td>Matches the agent’s dialed string to the Dial String indicated in the entry. This Dial String is used to place the call (the call will not be routed by ICM software).</td>
</tr>
<tr>
<td></td>
<td>• Indicate the appropriate Wildcard character.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Set the PostRoute field to <strong>No</strong>.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Identify a valid Dial String used to place the call.</td>
<td></td>
</tr>
<tr>
<td></td>
<td>• Set the Dial Number Type Plan to indicate the type of call.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><strong>Example:</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>ICM Configuration Manager &gt; Tools &gt; Bulk Configuration &gt; Insert &gt; Dialed Number Plan Bulk Insert</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Ensure Agent Desk Settings are set to identify the types of calls agents can place.</td>
<td>Ensures that agents make only the types of outbound calls they are permitted to make.</td>
</tr>
<tr>
<td></td>
<td><strong>Example:</strong></td>
<td></td>
</tr>
<tr>
<td></td>
<td>ICM Configuration Manager &gt; Tools &gt; List Tools &gt; Agent Desk Settings List</td>
<td></td>
</tr>
</tbody>
</table>

**See Also**

For more information on ICM Routing Scripts, refer to the *ICM Scripting and Media Routing Guide for Cisco ICM/IPCC Enterprise & Hosted Editions*.

For more information on Agent Desk Settings, see *About Agent Desk Settings (page 7)*.
ICM Message Delivery Service (MDS) Performance Meter

There are overheads in maintaining MDS meters. The application needs to have a block of memory that stores current counter data, and periodically it must update these values. Furthermore, synchronizing access to the counter values adds serious burdens to the system. For these reasons, the performance monitoring feature is turned off by default.

To turn on the feature, change one or both of the following registry key values to 1.

• For the MDS process (required for the Cisco ICM MDSPROC and Cisco ICM MDSPROCCNCLIENT performance objects mentioned below):
  HKEY_LOCAL_MACHINE\Software\Cisco Systems, Inc.\ICM\<instance>\<node>\MDS\CurrentVersion\Process\EnablePerformanceMonitor

• For the MDS client (required for the Cisco ICM MDSCLIENT performance object mentioned below): HKEY_LOCAL_MACHINE\Software\Cisco Systems, Inc.\\ICM\<instance>\<node>\MDS\CurrentVersion\Clients\<client>\EnablePerformanceMonitor

where rtr (router) is an example of a <client>.

System Performance Monitor introduces overheads itself and the overheads depend on the periodic update interval, which is set as the minimum 1 second by default. This interval should be set reasonably high to minimize the impact on the system.

The assumption is that extensive metering will not be performed while the system is performing as expected. Only in exceptional cases would close monitoring of the system be desirable.

This chapter contains the following topics:

• Charting MDS Values, page 58
• Cisco ICM MDS Meters, page 59
Charting MDS Values

To chart MDS, perform the following steps from the Add Counters dialog box:

Step 1  Click the radio button: Select counters from computer.

Step 2  From the Performance object drop-down list, select Cisco ICM MDSCLIENT, Cisco ICM MDSPROC, or Cisco ICM MDSPROCLIENT.

Step 3  From the Instance list, select that instances that you want to chart: <cust>, <nodes>, <process> (_Total is not actually an instance of the object, but a pseudo-instance. If _Total is selected, each selected counter will contain the sum of the values for all the instances.)

Step 4  Click the radio button: Select counters from list.

Step 5  Select the counter values to chart OR to select all the counter values for charting by clicking the radio button All counters.

Step 6  Click the Add button to add the values that you selected to the current chart.

Cisco ICM MDS Meters (page 59) and Additional Cisco ICM MDS Meters (page 60) list the meters that are provided if you select Cisco ICM MDSPROC. Cisco ICM MDS Meters - client statistics as seen by process (page 61) lists the meters that are provided if you select Cisco ICM MDSPROCLIENT.

Cisco ICM MDS Meters - client statistics as seen by client (page 62) lists the meters that are provided if you select Cisco ICM MDSCLIENT.

MDS maintains a number of different queues, among which are:

- Local Incoming Queue
- Remote Output Queue
- Local Ordering Queue
- Remote Ordering Queue
- Timed Delivery Queue

A high, medium, and low priority counter is provided for each of the above queues.

Cisco ICM MDS Meters (page 59) is presented in a condensed form to reduce repetition. For the string QQQQ you can substitute any of the following values:

- LocalHighInQ
- LocalMedInQ
• LocalLowInQ
• RemoteHighOutQ
• RemoteMedOutQ
• RemoteLowOutQ
• LocalHighOrderQ
• LocalMedOrderQ
• LLocalLowOrderQ
• RemoteHighOrderQ
• RemoteMedOrderQ
• RemoteLowOrderQ
• TDHighQ
• TDMedQ
• TDLowQ

where:
• High stands for "high priority"
• Med stands for "medium priority"
• Low stands for "low priority"
• In stands for "incoming"
• Out stands for "output"

Cisco ICM MDS Meters

<table>
<thead>
<tr>
<th>Counter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>QQQ Current Depth</td>
<td>Current number of messages in the queue.</td>
</tr>
<tr>
<td>QQQ Now Messages In/sec</td>
<td>Total number of messages added to the queue during last second.</td>
</tr>
<tr>
<td>QQQ Now Messages Out/sec</td>
<td>Total number of messages removed from the queue during last second.</td>
</tr>
</tbody>
</table>
Cisco ICM MDS Meters

<table>
<thead>
<tr>
<th>Counter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>QQQ Now Bytes In/sec</td>
<td>Total number of bytes added for all the messages to the queue during last second.</td>
</tr>
<tr>
<td>QQQ Now Bytes Out/sec</td>
<td>Total number of bytes removed for all the messages from the queue during last second.</td>
</tr>
<tr>
<td>QQQ Now Traffic Intensity</td>
<td>Ratio (x 100) of the number of messages added to the number of messages removed from the queue during last second.</td>
</tr>
<tr>
<td>QQQ Avg. Queue Response Time [ms]</td>
<td>Average time in milliseconds a message waits in the queue.</td>
</tr>
<tr>
<td>QQQ 90% Queue Response Time [ms]</td>
<td>The response time in milliseconds that 90% of all messages passing through the queue will experience.</td>
</tr>
</tbody>
</table>

The following meters are also provided for the MDS process.

Additional Cisco ICM MDS Meters

<table>
<thead>
<tr>
<th>Counter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Current Buffers Memory Allocated</td>
<td>Total number of bytes used by all currently allocated buffers.</td>
</tr>
<tr>
<td>Current Buffers Allocated</td>
<td>Total number of buffers currently allocated from buffer pool.</td>
</tr>
<tr>
<td>Buffers Allocation Requests/sec</td>
<td>Number of buffers allocated during last second.</td>
</tr>
<tr>
<td>Buffers Free Requests/sec</td>
<td>Number of buffers freed during last second.</td>
</tr>
<tr>
<td>Current Buffers Memory Limit</td>
<td>Maximum amount of memory (in bytes) allowed to be allocated for buffers for this process.</td>
</tr>
<tr>
<td>Initial Buffers Memory Limit</td>
<td>Amount of memory limit (in bytes) reserved for buffers for this process.</td>
</tr>
<tr>
<td>Synch Messages Ordered/sec</td>
<td>Number of messages ordered by the MDS synchronizer during last second.</td>
</tr>
<tr>
<td>Synch MDS Duplicates/sec</td>
<td>Number of duplicate MDS messages detected by the synchronizer during last second.</td>
</tr>
<tr>
<td>Synch DMP Duplicates/sec</td>
<td>Number of duplicate DMP messages detected by the synchronizer during last second.</td>
</tr>
<tr>
<td>Output Waits/sec</td>
<td>Number of times output from critical client (Route or OPC) waited for ACK from MDS peer during last second.</td>
</tr>
<tr>
<td>Average Output Wait Time</td>
<td>Average number of milliseconds MDS output waits to receive an ACK message from MDS peer.</td>
</tr>
<tr>
<td>Private Net Min RTT</td>
<td>Minimum time (in milliseconds) it took MDS to send a message over the private network and receive an ACK response from MDS peer.</td>
</tr>
<tr>
<td>Private Net Avg RTT</td>
<td>Average time (in milliseconds) it took MDS to send a message over the private network and receive an ACK response from MDS peer.</td>
</tr>
</tbody>
</table>
The following meters are provided by the MDS process for each MDS client (statistics as seen by the MDS process, not by the MDS client itself).

Cisco ICM MDS Meters - client statistics as seen by process

<table>
<thead>
<tr>
<th>Counters</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client Handle ID</td>
<td>Handle for this MDS client. It is used to uniquely identify the MDS client connected to the MDS process.</td>
</tr>
<tr>
<td>Total MDS Client Connects</td>
<td>Total number of times the MDS client has connected to the MDS process.</td>
</tr>
<tr>
<td>Total MDS Client Disconnects</td>
<td>Total number of times the MDS client has disconnected from the MDS process.</td>
</tr>
<tr>
<td>Now Message Received from Client</td>
<td>Number of messages received from the MDS client during last second.</td>
</tr>
<tr>
<td>Now Message Sent to Client</td>
<td>Number of messages sent to the MDS client during last second.</td>
</tr>
<tr>
<td>Now Bytes Received from Client</td>
<td>Number of bytes received from the MDS client during last second.</td>
</tr>
<tr>
<td>Now Bytes Sent to Client</td>
<td>Number of messages sent to the MDS client during last second.</td>
</tr>
<tr>
<td>ToClientQ Current Depth</td>
<td>Current number of messages in the Send to MDS Client Queue.</td>
</tr>
<tr>
<td>ToClientQ Now Messages In/sec</td>
<td>Total number of messages added to the Send to MDS Client Queue during last second.</td>
</tr>
<tr>
<td>ToClientQ Now Messages Out/sec</td>
<td>Total number of messages removed from the Send to MDS Client Queue during last second.</td>
</tr>
<tr>
<td>ToClientQ Now Bytes In/sec</td>
<td>Total number of bytes added for all the messages to the Send to MDS Client Queue during last second.</td>
</tr>
<tr>
<td>ToClientQ Now Bytes Out/sec</td>
<td>Total number of bytes removed for all the messages from the Send to MDS Client Queue during last second.</td>
</tr>
<tr>
<td>ToClientQ Now Traffic Intensity</td>
<td>Ratio (x 100) of the number of messages added to the number of messages removed from the Send to MDS Client Queue during last second.</td>
</tr>
<tr>
<td>ToClientQ Avg. Queue Response Time [ms]</td>
<td>Average time in milliseconds a message waits in the Send to MDS Client Queue.</td>
</tr>
<tr>
<td>ToClientQ 90% Queue Response Time [ms]</td>
<td>The response time in milliseconds that 90% of all messages passing through the Send to MDS Client Queue will experience.</td>
</tr>
</tbody>
</table>
The following meters are provided for each MDS client (statistics as seen by the MDS client itself, not by the MDS process).

Cisco ICM MDS Meters - client statistics as seen by client

<table>
<thead>
<tr>
<th>Counter</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Client Handle ID</td>
<td>Handle for this MDS client. It is used to uniquely identify the MDS client connected to the MDS process.</td>
</tr>
<tr>
<td>Now Message Received</td>
<td>Number of messages received by the MDS client during last second.</td>
</tr>
<tr>
<td>Now Message Sent</td>
<td>Number of messages sent by the MDS client during last second.</td>
</tr>
<tr>
<td>Now Bytes Received</td>
<td>Number of bytes received by the MDS client during last second.</td>
</tr>
<tr>
<td>Now Bytes Sent</td>
<td>Number of bytes sent by the MDS client during last second.</td>
</tr>
<tr>
<td>Current Buffers Memory Allocated</td>
<td>Total number of bytes used by all currently allocated buffers.</td>
</tr>
<tr>
<td>Current Buffers Allocated</td>
<td>Total number of buffers currently allocated from buffer pool.</td>
</tr>
<tr>
<td>Buffers Allocation Requests/sec</td>
<td>Number of buffers allocated during last second.</td>
</tr>
<tr>
<td>Buffers Free Requests/sec</td>
<td>Number of buffers freed during last second.</td>
</tr>
<tr>
<td>Current Buffers Memory Limit</td>
<td>Maximum amount of memory (in bytes) allowed to be allocated for buffers for this process.</td>
</tr>
<tr>
<td>Initial Buffers Memory Limit</td>
<td>Amount of memory limit (in bytes) reserved for buffers for this process.</td>
</tr>
<tr>
<td>SendClientQ Current Depth</td>
<td>Current number of messages in the Send by MDS Client Queue.</td>
</tr>
<tr>
<td>SendClientQ Now Messages In/sec</td>
<td>Total number of messages added to the Send by MDS Client Queue during last second.</td>
</tr>
<tr>
<td>SendClientQ Now Messages Out/sec</td>
<td>Total number of messages removed from the Send by MDS Client Queue during last second.</td>
</tr>
<tr>
<td>SendClientQ Now Bytes In/sec</td>
<td>Total number of bytes added for all the messages to the Send by MDS Client Queue during last second.</td>
</tr>
<tr>
<td>SendClientQ Now Bytes Out/sec</td>
<td>Total number of bytes removed for all the messages from the Send by MDS Client Queue during last second.</td>
</tr>
<tr>
<td>SendClientQ Now Traffic Intensity</td>
<td>Ratio (x 100) of the number of messages added to the number of messages removed from the Send by MDS Client Queue during last second.</td>
</tr>
<tr>
<td>SendClientQ Avg. Queue Response Time [ms]</td>
<td>Average time in milliseconds a message waits in the Send by MDS Client Queue.</td>
</tr>
<tr>
<td>SendClientQ 90% Queue Response Time [ms]</td>
<td>The response time in milliseconds that 90% of all messages passing through the Send by MDS Client Queue will experience.</td>
</tr>
</tbody>
</table>
Index

/PI...45
Agent
    configuring Not Ready reason codes...35
database records...8
teams, creating...33
teams, deleting...34
Agent desk settings
    about...9
    Idle reason required...14
    Logout reason required...14
    reason codes...14
    Work mode...14
    Wrap-up...14
Agent desktop features...13
Agent Re-skilling tool
    about...19
    accessing...41
Agents
    about...7
    administering...7
    changing skill group designations...19
    creating multichannel...34
    creating voice-only...31
    deleting multichannel...34
    deleting voice-only...32
    entering Wrap-up mode...13
    multichannel...7
    multichannel, creating...34
    multichannel, deleting...34
    reason codes...14
    supervisors...9
    teams...9
teams, multichannel...10
    voice-only...7
Agent supervisor
    creating...33
deleting...33
Agent teams
    about...9
    creating...33
deleting...34
Agent types
    multichannel...7
    voice-only...7
Agent wrap-up...13
    configuring...39
Alphanumeric substitutions, configuring...53
Alpha prefixes, adding to numbers...53
Assist call method, configuring...39
Barge-in option...18
Base skill groups...25
    migrating from subskill groups...26
CAD
    configuring supervisor logged-in state...40
    configuring Work Mode on Incoming option...15
    configuring Work Mode on Outgoing option...15
    predefined reason codes...15
Call forward on Redirection on No Answer...17
Call forward on Ring No Answer
    configuring IPCC on CVP...37
    configuring IPCC on IP IVR...36
Call types...23
Call types, identification...53
Cisco Collaboration Server...28
Cisco Media Blender...28
Classifying call types...53
Collaboration Server...28
ConfigLimit tool....19
Configuration Parameters....45
Configuring
  agent teams....33
  alphanumeric substitutions....53
Assist call and Emergency alert methods....39
automatic wrap-up....39
CAD supervisor logged-in state....40
device target with IPCC Enterprise....45
multichannel software, about....28
network transfer from a CTI OS Agent Desktop....43
network transfer from an IP phone....42
Not Ready reason codes....35
routing, about....23
speed dialing....52
Static Dial String translations....52
Work Mode on Incoming option for CAD....15
Work Mode on Incoming option for CTI OS Agent Desktop....14
Work Mode on Outgoing option for CAD....15
Creating
  agents....31
  agent supervisor....33
  agent teams....33
  multichannel agents....34
  voice-only agents....31
CTI OS Agent Desktop
  configuring network transfer....43
  configuring Work Mode on Incoming option....14
Database
  Agent record....8
  Person record....8
  records for IPCC Enterprise agents using multichannel software....8
Deleting
  agent supervisor....33
agent teams....34
  multichannel agents....34
  Voice-only agents....32
Desk settings, agent....13
Desktop features, configuring....13
Device target
  routing to a new....46
Device targets....24
  configuring with IPCC Enterprise....45
Dial Number Plan....49
  alphanumeric substitutions....50
  configuring....50
  dialed number....50
  dial number type plan....53
  dial string....53
  Post Route....50
  Post Route field....51
  routing agent-initiated calls....50
  Routing Client field....51
  specifying basic dialing substitutions....50
  speed dialing....52
  values....50
  Wildcard pattern....51
Dialled numbers....23
Dialing substitutions, Dialled Number Plan....50
Dial string
  using for alphanumeric substitutions....53
Duplicate extensions....45
Emergency alert method, configuring....39
Emergency calls....17
Intercept option....19
IPCC Enterprise, performing administrative tasks....31
IPCC Enterprise Web Administration Tool, about....1
Labels....24
Index

skill groups....19
Media Blender....28
Migrating from subskill groups to base skill groups....26
Modes, Wrap-up....13
Multichannel agent database records....8
Multichannel agents....7
creating....8, 34
deleting....34
Multichannel routing, about configuring....27
Multichannel routing requests, about....27
Multichannel software
Cisco Collaboration Server....28
Cisco E-Mail Manager....28
Cisco Media Blender....28
configuring....28
database records for IPCC Enterprise agents....8
Multi-site installations
duplicate extensions....45
Network transfer
configuring from a CTI OS Agent Desktop....43
configuring from an IP Phone....42
for IVRs, about....21
Person database record....8
Predefined reason codes....15
Queue requests....22
Reason codes....14
configuring....35
idle reason required....14
logout reason required....14
predefined....15
Wrap-Up....14
Redirection on No Answer
about....17
configuring IPCC on CVP....37
configuring IPCC on IP IVR....36
Route requests....22
Routes....24
Routing
about IPCC Enterprise....21
agent calls with the Dialed Number Plan....50
and queuing requests....22
call to the VRU....22
call types....23
client....21
configuration, about....23
configuring for multichannel, about....27
device targets....24
dialed numbers....23
labels....24
multichannel requests, about....27
operations, about....21
scripts, about....26
services....25
skill groups....25
subskill groups....25
to a target device....46
to the VRU with IPCC Enterprise....22
voice calls....45
VRU....22
Scripts
routing, about....26
Services....25
skill group limit....19
Skill groups
base....25
changing agent designation....19
migrating from subskills to base skills....26
sub....25
Speed
dial, configuring....53
dialing, Dialed Number Plan....52
Speed dialing, configuring....52
Static dial string translations....52
Subskill group masks....25
Subskill groups....25
    enabling the subskill group mask....25
    migrating to base skill groups....26
Supervisor
    assist calls....17, 39
    creating agent....33
    deleting agent....33
    required information when creating....10
Supervisor features
    configuring, about....18
    configuring, how to....40
    monitoring agent team members....18
Supervisors
    assigning primary and secondary....9
    using Barge-In option....18
    using Intercept option....19
    using the Agent Re-skilling Tool....19
System IPCC
    performing administrative tasks....1
Target devices....46
Teams
    agent....9
    creating agent....33
    deleting agent....34
Voice calls, routing....45
Voice-only agents....8
    creating....31
    deleting....32
VRU routing....22
Web collaboration....28
Wildcard characters
    combining with alphanumeric substitution....53
Work mode, agent wrap-up....14
Wrap-up....13
    configuring....39
    reason codes....14
    reason codes and work mode....14
Wrap-Up reason codes and work mode....14